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Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez I'Aide de I'application.

Windows ou Linux | Equivalent Mac Effet

Sélection du menu

- . LibreOffice > Préférences Acces aux options de configuration
Outils > Options

Control+clicouclic droit

Clic droit . . - Ouvre un menu contextuel
selon la configuration de l'ordinateur
Ctrl (Control) (Command) Utilisé avec d’autres touches
F5 Shift+@®+F5 Ouvre le navigateur
F11 @+T Ouvre l'onglet Styles et Formatage

du volet latéral
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Imprimer

Impression rapide

Pour imprimer rapidement un classeur, cliquez sur le bouton Imprimer directement & de la barre
d’outils Standard pour envoyer la totalité du document a I'imprimante par défaut définie pour votre
ordinateur.

Eg Remarque

Vous pouvez modifier I'action de I'icbne Imprimer directement pour envoyer le document a
limprimante définie pour celui-ci au lieu de I'imprimante par défaut de I'ordinateur. Ouvrez la
page Chargement/enregistrement — Général de la boite de dialogue Options (Outils > Op-
tions) et cochez I'option Charger les paramétres d’impression avec le document.

/Q\ Conseil
Si I'icbne Imprimer directement n’apparait pas dans la barre d’outils, vous pouvez I'y ajou-
ter. Voyez le chapitre 14, Paramétrer et personnaliser Calc.

Impression contrélée

Pour avoir plus de contréle sur I'impression, sélectionnez Fichier > Imprimer dans la barre de
menu ou appuyez sur Ctr L+P pour ouvrir la boite de dialogue Imprimer (Figure 1).

Imprimer

Général LibreOffice Calc Mise en page Options

Imprimante
210 mm (A4) ECanon MG8200 series Printer XPS

v

Détails o
== Proprietés...

Plage et exemplaires
OToutes les feuilles Nombre d'exemplaires |1 =

® Feuilles sélectionnées 1
O Cellules sélectionnées B ﬂ@

Dont imprimer

297 mm

@® Toutes les pages
OPages 1-4

1/4 v [Imprimer dans l'ordre inverse

Aide Annuler

Figure 1 : I'onglet Général de la boite de dialogue Imprimer.

o~

= Remarque

Les options sélectionnées dans la boite de dialogue Imprimer ne s’appliquent qu’a I'impres-
sion du document ouvert.
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Pour spécifier des parameétres d'impression par défaut pour LibreOffice, ouvrez les pages
LibreOffice > Impression et LibreOffice Calc > Imprimer de la boite de dialogue Options (Ou-
tils > Options). Voir le chapitre 14, Paramétrer et personnaliser Calc, pour les détails.

La boite de dialogue Imprimer posséde quatre onglets ou vous pouvez sélectionner toute une
gamme d’options décrites ci-dessous.

Selon le systeme d’exploitation de votre ordinateur, la disposition de ces onglets peut étre diffé-
rente de celle des illustrations de ce chapitre.

Onglet Général
Dans l'onglet Général de la boite de dialogue Imprimer (Figure 1), vous pouvez choisir
«  limprimante utilisée dans la liste des imprimantes disponibles de la section Imprimantes,

« dans la section Pages et exemplaires, les feuilles et les pages a imprimer, le nombre de co-
pies a réaliser, s'il faut les assembler et dans quel ordre les imprimer (voir « Sélectionner ce
que I'on veut imprimer », page 3),

* des propriétés spécifiques a I'imprimante, comme la taille du papier, son orientation, I'impres-
sion recto-verso si elle est disponible ou le bac a papier a utiliser.

Onglet LibreOffice Calc

Dans l'onglet LibreOffice Calc de la boite de dialogue Imprimer (Figure 2), vous pouvez choisir
d’ignorer ou non les pages vides au cours de I'impression du classeur.

Imprimer

Général LibreOffice Calc Mise en page Options
Pages

210 mm (A4 Mignorer les pages vides pour l'impression

il

- Figure 2 : I'onglet LibreOffice Calc de la boite de dialogue Imprimer.

Onglet Mise en page

Dans l'onglet Mise en page de la boite de dialogue Imprimer (Figure 3), vous pouvez choisir le
nombre de pages imprimées par feuille de papier, I'ordre dans lequel elles seront imprimées sur la
feuille et s'il faut tracer ou non une bordure autour de chaque page.

Imprimer

Geéneral LibreOffice Calc Mise en page Options

Mise en page

210 mm (A4) Pages par feuille 1

= el o P el Ordre ‘de gauche a droite, puis en bas V‘

[IDessiner une bordure autour de chaque page

Figure 3 : I'onglet Mise en page de la boite de dialogue Imprimer.
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Onglet Options

Dans I'onglet Options de la boite de dialogue Imprimer (Figure 4) vous pouvez décider de créer
des taches d'impression séparées pour les sorties assemblées et de n'utiliser que la taille de pa-

pier définie dans les parametres de I'imprimante.

Général LibreOffice Calc Mise en page Options

Options

210 mm (A4) [“ICréer des taches d'impression séparées pour les sorties assemblées

Figure 4 : I'onglet Options de la boite de dialogue Imprimer.

=

Imprimer plusieurs pages sur une seule feuille de papier

. ‘ [ Utiliser uniqguement |a taille du papier suivant les préférences de l'imprimante.

Vous pouvez imprimer plusieurs pages d'un document sur une seule feuille de papier. Pour cela :

1) Dans la boite de dialogue Imprimer, ouvrez I'onglet Mise en page (Figure 5).

2) Dans la section Mise en page, choisissez, dans la liste déroulante, le nombre de pages a
imprimer par feuille. La vignette a gauche de la boite de dialogue Imprimer montre I'aspect

gu’aura le document imprimé.

Geéneral LibreOffice Calc Mise en page Options

Mise en page

Pages par feuille ‘2 V‘ 1 2
RN o s pus vrs o ot B

de gauche a droite, puis en bas

de haut en bas, puis vers la droite
de haut en bas, puis a gauche

de droite & gauche, puis vers le bas

= i (64) [ 1Dessiner une |

210 mm

Figure 5 : Imprimer plusieurs pages sur une feuille de papier.

3) Quand vous imprimez plus de 2 pages par feuilles, vous pouvez choisir I'ordre dans lequel

elles sont imprimées sur la feuille.

4)  Pour délimiter chaque page sur la feuille, cochez Dessiner une bordure autour de chaque

page.
5) Cliquez sur le bouton OK.

Sélectionner ce que I’on veut imprimer

En plus d’'imprimer un classeur dans sa totalité, vous pouvez choisir d'imprimer des feuilles indivi-

duelles, des groupes de feuilles ou des sélections de cellules.
Pour imprimer une seule feuille :

1) Dans le classeur, sélectionnez la feuille & imprimer en cliquant sur son onglet.
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2) Choisissez Fichier > Imprimer dans la barre de menu ou appuyez sur Ctr 1+P.

3) Dans la section Plage et exemplaires de la boite de dialogue Imprimer (Figure 1), cochez
Feuilles sélectionnées.

4)  Cliquez sur OK.
Pour imprimer une série de feuilles :

1) Dans le classeur, sélectionnez les feuilles a imprimer.

2) Choisissez Fichier > Imprimer dans la barre de menu ou appuyez sur Ctr l+P.

3) Dans la section Plage et exemplaires de la boite de dialogue Imprimer (Figure 1), cochez
Feuilles sélectionnées.

4)  Cliquez sur OK.
Pour imprimer une sélection de cellules :

1) Dans le classeur, sélectionnez les cellules a imprimer.

2) Choisissez Fichier > Imprimer dans la barre de menu ou appuyez sur Ctr [+P.

3) Dans la section Plage et exemplaires de la boite de dialogue Imprimer (Figure 1), cochez
Cellules sélectionnées.

4) Dans la sous-section Dont imprimer, cochez Pages et tapez 1 dans la boite de saisie.

5) Cliguez sur OK.

Imprimer en niveaux de gris (avec une imprimante couleur)

Il peut arriver que vous souhaitiez imprimer des documents en niveaux de gris sur une imprimante
couleur. Plusieurs solutions sont possibles.

~.z >
L TP
—~

Remarque

Certaines imprimantes en couleurs peuvent imprimer en couleurs indépendamment des pa-
rametres que vous définissez.

Pour imprimer un seul fichier, vous pouvez madifier la configuration de I'imprimante pour imprimer
en noir et blanc ou en niveaux de gris :

1) Choisissez Fichier > Imprimer dans la barre de menu ou appuyez sur Ctr I+P pour ouvrir la
boite de dialogue Imprimer.

2) Cliguez sur le bouton Propriétés pour ouvrir la boite de dialogue de Propriétés de I'impri-
mante. Les choix possibles varient d’'une imprimante a I'autre, mais vous devriez trouver des
options de paramétrage des couleurs. Voyez I'aide ou le guide de Il'utilisateur de votre impri-
mante pour plus d’informations.

3) Parmiles choix possibles, vous pouvez trouver noir et blanc ou niveaux de gris. Sélectionnez
niveaux de gris.

4)  Cliquez sur OK pour confirmer votre choix et revenir a la boite de dialogue Imprimer.

5) Cliquez sur OK pour imprimer le document.
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Vous pouvez modifier la configuration de LibreOffice pour imprimer en niveaux de gris les textes et
objets graphiques en couleur :

1)

2)

Sélectionnez Outils > Options pour ouvrir la boite de dialogue Option puis choisissez la
page LibreOffice — Impression.

Cochez I'option Convertir les couleurs en niveaux de gris. Cliqguez sur OK pour enregistrer la
modification.

Cette modification des options d’impression ne s’applique pas seulement a Calc, mais a
tous les modules de LibreOffice.

Apercu des pages avant impression

Pour utiliser 'apergu avant impression dans Calc :

1)

2)

3)
4)

Choisissez Fichier > Apercu, cliquez sur le bouton Apergu [ & dans la barre d’outils Stan-
dard ou appuyez sur Ctr l+Maj+0. Calc affiche alors la barre d’outils Apercu a la place de la
barre d’outils Formatage.

< > Q >| @\ @\ S EI D - ] + Fermer l'apercu

Figure 6 : La barre d’outils Apercu

Pour imprimer le document & partir de cette vue, cliquez sur l'icone Imprimer (i), dans la
barre d’outils Standard, pour ouvrir la boite de dialogue Imprimer.

Choisissez les options d’'impression et cliquez sur le bouton OK.

Cliquez sur le bouton Fermer I’apercu pour revenir a la vue normale du classeur.

Utiliser les zones d’impression

Vous pouvez définir les plages de cellules du classeur a imprimer ou a exporter en PDF. Les cel-
lules de la feuille qui ne font pas partie d’'une zone d’'impression ne sont ni imprimées ni exportées.
De plus les feuilles sans zone d’'impression définie ne sont ni imprimées ni exportées.

Définir et imprimer une zone d’impression

Pour définir une zone d’'impression et remplacer toute zone d’impression déja définie :

1)
2)

3)

Sélectionnez la plage de cellules qui sera la zone d’'impression.

Choisissez Format > Zones d’impression > Définir dans la barre de menu. Des lignes de
sauts de page automatiques, qui définissent les cellules incluses dans la zone d’impression,
s’affichent sur I'écran.

Les lignes de délimitation des pages s'affichent a I'écran.

Cliquez sur 'icone Imprimer directement i= de la barre d’outils Standard ou ouvrez la boite
de dialogue Imprimer et cliquez sur OK pour imprimer la zone d’impression définie.
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’Q\ Conseil
Vous pouvez vérifier la zone d’'impression en utilisant le bouton Apercu | & dans la barre

d’outils Standard ou I'apercu de la boite de dialogue Imprimer. Calc n’affichera que les cel-
lules dans la zone d'impression. Voir « Visualiser les zones d’impression », page 7.

Modifier une zone d’impression

Vous pouvez modifier a tout moment la zone d’impression, par exemple pour lui ajouter ou lui enle-
ver des cellules, ou pour définir les lignes et les colonnes a répéter sur toutes les pages (comme
les lignes et colonnes d'en-téte).

1) Sélectionnez Format > Zones d’impression > Editer dans la barre de menu pour ouvrir la
boite de dialogue Editer les zones d’'impression (Figure 7).

Editer les zones d'impression

Zones d'impression

‘— défini par l'utilisateur - V‘ $A$1:$B$8:$D$3:$ES7 g2

Lignes a répéter
‘, défini par l'utilisateur - V‘ $1:94 =

Colonnes a repéter

‘— défini par l'utilisateur - V‘ $A$C g2

Aide Annuler

Figure 7 : la boite de dialogue Editer les zones d’'impression.

2) Sivous cliguez dans la boite de saisie Zones d’impression, les différentes plages de la
zone d’impression sont entourées en couleurs différentes (bleu pour la premiére, rouge pour
la deuxieme, magenta pour la suivante...) comme sur la Figure 8.

A | B c | o | E |

m‘ﬂ‘m‘m‘h‘w‘w‘g

Figure 8 : la premiére plage de la zone d’impression est entourée en bleu,
la seconde en rouge.

3) Pour ajouter de nouvelles cellules a la zone déja définie, tapez un point-virgule* a la fin du
contenu de la boite de saisie Zones d’impression pour le séparer de la plage a ajouter. Sé-
lectionnez celle-ci dans le classeur (aprés avoir cliqué sur le bouton a droite de la boite de
saisie) ou tapez sa référence en utilisant le format des plages déja définies. N'oubliez pas de
séparer les références des cellules par un caractére deux-points.

1 Ce séparateur dépend de la langue. Il est défini dans la page LibreOffice Calc — Formule de la boite
de dialogue Options, par le contenu de la boite de saisie Fonction de la section Séparateurs.
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4)

5)

Pour supprimer une plage de cellule de la zone d’'impression, effacez-la de la boite de saisie
Zones d’'impression. Faites attention que les autres plages soient bien séparées par un
point-virgule® et qu’il N’y en ait pas a la fin de la suite de plages.

Cliquez sur OK pour enregistrer les modifications et refermer la boite de dialogue.

Visualiser les zones d’'impression

Quand les zones d'impression ont été définies, elles sont automatiquement formatées avec des
sauts de page. Pour voir ceux-ci, sélectionnez Affichage > Sauts de page dans la barre de menu
pour ouvrir I'apercu (Figure 9).

A B Cc |D|E| F |G| H | J | K

Classe Geme 1 Date 15/03( 23/03| 25/03| 01/04 09i04) 12i04) 03/05| O5i

Année 20102011  [Devoir [Exos |[DM7 |Exosup [IE |EDiv  [DS6  [DM6Bis [Exos

Trimestre

[Prénoms Moy icoef 1,0 1,0| 1,0} 2,0] 2,0] 3,0] 1,0| 1

Lyndsay 7.7] 110 55| 5,5 145 100 130 C

Maelia 16,91 20,01 190 180] 120 20,0 17.9 115 2C

Camille 15,7 130 150 155 175 125 200| 2

Laurine 7.1 6,0 85| 4.0 00 5,5 65 1C

| A nthony 6.4 8,0 00| 85 110 6,04 00 1C

] ITipheune 64jabs  [Abs 40/abs  |Abs Abs

) Leo 168.8] 20,0( 200 2001 175 19.0) 17 5] 20,0/Abs

| Lucas 12,8 150/ 180 115 14 0| 8.5| 100 1

| Brandon 85| 12,0 9.0| 70 140 3.0 00 1€

| ceane 9,2JAbs 110 85 115 100 25 1E

| Gastan 6,20 13,0 00| 105 105 3.9 00 17

| laurélien 1291 140 160 110 155 115 85 17

| [Sarah 132] 200 125 160 125 0 135 200| 1E

| Mendi 119] 140 105 115 12,0 119 125 14
I Elisa

2 Enzo 9.6] 20,0 2,0 10.0) 17.5 ey 1.5 L

'§amy 153 19,0/ 180 145 175 145 160 14

Coralie 74 18,0 7.5| 9.0l 115 95| 105 L

Tom 97| 00 165 8,0| 8,0| 12,0 135 1&

Bélinda 129 110 150 125 140 10,0/ 140 17

- Timothée 129 140 165 15,0 145 10,0/ 70 2C

"Figure 9: aperéil des sauts de page.

Les zones d'impression sont par défaut entourées d’une bordure bleue et contiennent en leur
centre leur numéro de page en gris trés clair. Les parties non imprimées du classeur apparaissent
normalement sur un fond gris fonce.

Pour quitter cet apercu des sauts de page, sélectionnez Affichage > Normal dans la barre de
menu.

Zones d’'impression nommées

En plus de définir une zone pour chaque tache d'impression, vous pouvez aussi définir une plage
de cellules utilisée de fagon répétée, sans avoir a sélectionner a chaque fois les cellules. Cela se
révele utile si différentes zones d’un classeur étendu doivent étre imprimées pour des rapports dif-
férents ; plusieurs zones d'impression nommées peuvent étre définies pour correspondre a ce be-

soin.

Définir et nommer une zone

1)

2)

Sélectionnez les cellules que vous souhaitez définir comme zone d'impression nommeée puis
choisissez Feuille > Plages et expressions nommées > Définir dans la barre de menu
pour ouvrir la boite de dialogue Définir un nom (Figure 10). Les cellules sélectionnées sont
indiquées dans la boite de saisie Plage ou expression de formule.

Tapez un nom pour la zone dans la boite de saisie Nom. N'utilisez pour cela que des lettres,
des chiffres et des caractéres soulignés (), ni espace, ni tiret, ni autre caractere.
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3) Sinécessaire, vous pouvez maodifier ou définir la plage de cellules sélectionnées dans la
boite de saisie Plage ou expression de formule. Voir « Modifier une zone d’impression »,
page 6, pour plus d’'informations.

4)  Vérifiez que I'option choisie dans Etendue est bien Document (global) avant de définir la
plage comme zone d’'impression.

5) Cochez Zone d’impression dans la section Options de la plage.

6) Cliguez sur Ajouter pour accepter les données et refermer la boite de dialogue.

Définir un nom

Définir le nom et la plage ou I'expression de formule.
Nom :
Nom_Prénom

Plage ou expression de formule :

$'3eme trim".$A%4:5B$33 5
Etendue
Document (global) v ‘

[=I Options de la plage

[“1Zone d'impression [IRépéter la colonne
LIFiltre [IRépéter la ligne
Aide Ajouter || Annuler

Figure 10 : la boite de dialogue Définir un nom.

Imprimer une zone nommeée
Pour sélectionner une plage nommée et I'imprimer :

1) Sélectionnez Format > Zones d’impression > Editer dans la barre de menu pour ouvrir la
boite de dialogue Editer les zones d’impression (Figure 11).

Editer les zones d'impression

Zones d'impression

Nom Prénom  EINISSRIIEE =
- aucun(e)-

L
- feuille entiére -
- défini par I'utilisateur - =
- sélection -
$ASC Er

Aide Annuler

Figure 11 : choix d’'une zone nommée a imprimer.

2) Choisissez la zone d’'impression nommée dans la liste déroulante Zones d’impression.
3) Cliguez sur OK pour refermer la boite de dialogue.

4)  Ouvrez la boite de dialogue Imprimer qui n’affiche maintenant que la zone d’'impression nom-
mée dans son apercu. Cliquez sur OK.
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Supprimer une zone d’impression nommeée
Pour supprimer une zone d’'impression nommeée qui n’est plus nécessaire :

1) Sélectionnez Feuille > Plages et expressions nommeées > Gérer dans la barre de menu
pour ouvrir la boite de dialogue Gérer les noms (Figure 12).

2) Choisissez la zone d’'impression nommée que vous souhaitez supprimer et vérifiez dans la
section Options de la plage gu’il s’agit bien d'une zone d’impression.

3) Cliguez sur Supprimer puis sur OK pour refermer la boite de dialogue.

Gérer les noms

|Nom |Plage ou expressi... |Etendue
Année $Liste.$A$2:$B$ Document (glob
Classe $Liste.$A$1:$B¢ Document (glob:
L $'3eme trim' $4 Document (glob:
Noms $Liste.$A$5:$A% Document (glob:
Prénoms $Liste.$B$5:$B$ Document (glob:
< >
Nom :

Nom_Prénom

Plage ou expression de formule :

$'3eme trim'.$A$4:$B$33 =
Etendue
Document (global) ~ ‘

[=I Options de la plage
[“IZone d'impression  []Répéter la colonne

LIFiltre [IRépéter la ligne

Ajouter Supprimer

Aide Annuler

Figure 12 : la boite de dialogue Gérer les noms.

Annuler les zones d’'impression

Il peut devenir nécessaire de supprimer une zone d’'impression définie, par exemple s'il faut impri-
mer la feuille entiere ou si on ne veut plus imprimer certaines des plages ajoutées.

Sélectionner Format > Zones d’impression > Effacer dans la barre de menu pour supprimer
toutes les plages d'impression définie dans le classeur, sauf les zones d’'impression nommeées.

Apres cela, les lignes des sauts de page par défaut pour la taille de papier choisie apparaitront sur
I'écran.

Pour supprimer les zones d’impression nommeées, voyez « Supprimer une zone d’'impression
nommeée » ci-dessus.

Utiliser les zones d’impression | 9



Répéter I'impression de lignes ou de colonnes

Si un classeur est imprimé sur plusieurs pages, vous pouvez que certaines lignes ou colonnes (les
en-tétes, par exemple) seront imprimées sur chaque page.

Avec les zones d’impression

1) Sélectionnez Format > Zones d’impression > Editer dans la barre de menu pour ouvrir la
boite de dialogue Editer les zones d’impression (Figure 13).

Editer les zones d'impression

Zones d'impression

‘— défini par l'utilisateur -~ ‘ $AST1:$VE42 =

Lignes a répéter
‘, défini par l'utilisateur - V‘ $1:94 =

Colonnes a repéter

‘— défini par l'utilisateur - V‘ $A$C g2

Aide Annuler

Figure 13 : lignes et colonnes a imprimer sur toutes les pages.

2) Dans la boite de saisie Lignes a répéter, saisissez les références des lignes a imprimer sur
toutes les pages. Par exemple, pour répéter les lignes 1 a 4, tapez $1:$4. Dans la liste dé-
roulante adjacente, I'option passe automatiquement de — aucun(e) — a — défini par I'utilisa-
teur —.

Vous pouvez aussi placer le curseur dans cette boite de saisie puis sélectionner avec la sou-
ris les lignes a répéter. Il n'est pas nécessaire de sélectionner toute la ligne.

3) La procédure est identique pour sélectionner les colonnes dans la section Colonnes a répé-
ter.

4)  Cliquez sur OK pour enregistrer les modifications et refermer la boite de dialogue.

Avec les zones d’impression nommeées

Il est aussi possible de définir des zones d'impression nommées utilisées pour répéter I'impression
de lignes ou de colonnes :

1) Définissez et nommez les lignes et les colonnes que vous désirez imprimer sur toutes les
pages. Voyez « Zones d’'impression nommeées », page 7, pour plus d’informations.

2) Cochez Répéter la colonne ou Répéter la ligne dans la section Options de la plage de la
boite de dialogue Définir un nom (Figure 10 page 8).

3) Cliguez sur Ajouter pour enregistrer les données et refermer la boite de dialogue.

4)  Choisissez Format > Zones d’impression > Editer dans la barre de menu pour ouvrir la
boite de dialogue Editer les zones d’impression (Figure 13).

5) Sélectionnez la zone d’impression nommeée dans les listes déroulantes Lignes a répéter ou
Colonnes a répéter.

6) Cliquez sur OK pour enregistrer les modifications et refermer la boite de dialogue.
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Sauts de page

Bien que les zones d’'impression soient des outils puissants, il peut parfois étre nécessaire d’ajus-
ter manuellement les sauts de page pour que le classeur soit imprimé comme vous le désirez.
Vous pouvez insérer deux types de sauts de page dans un classeur :

* les sauts de ligne sont des sauts de page horizontaux qui s’inserent au-dessus d’une cellule
sélectionnée dans une ligne. Par exemple, si la cellule sélectionnée est la cellule H15, le
saut de ligne est créé entre les lignes 14 et 15 ;

* les sauts de colonne sont des sauts de page verticaux qui s'inserent a gauche de la cellule
sélectionnée dans une colonne. Par exemple, si la cellule sélectionnée est la cellule H15, le
saut de colonne est créé entre les colonnes G et H.

Quand un saut de page manuel est inséré, il apparait sous forme d’une ligne bleue ou d’une ligne
épaisse entre les lignes ou les colonnes de la grille. Son apparence dépend des parameétres de
votre ordinateur. Pour les voir plus facilement, vous pouvez la modifier. Ouvrez la page LibreOffice
— Couleurs de l'interface de la boite de dialogue Options (Outils > Options) et descendez a la
section Classeur ou vous pourrez modifier leur couleur.

Insérer des sauts de page

1) Sélectionnez la cellule ou vous voulez insérer un saut de page manuel dans le classeur.

2) Choisissez Feuille > Insérer un saut de page dans la barre de menu.

3) Dans le sous-menu, sélectionnez Saut de ligne pour insérer un saut de page au-dessus de
la cellule ou Saut de colonne pour insérer un saut de page a gauche de la cellule.

Vous pouvez aussi sélectionner Affichage > Saut de page dans la barre de menu, faire un clic
droit sur le classeur et choisir Saut de ligne ou Saut de colonne dans le menu contextuel. N'ou-
bliez pas de revenir & la vue normale du classeur (Affichage > Normal).
Supprimer des sauts de page

1) Sélectionnez la cellule dont vous souhaitez supprimer le saut de page manuel.

2) Choisissez Feuille > Supprimer le saut de page dans la barre de menu.

3) Dans le sous-menu, sélectionnez Saut de ligne pour supprimer un saut de page au-dessus

de la cellule ou Saut de colonne pour supprimer un saut de page a gauche de la cellule.

Supprimer tous les sauts de page

Plusieurs sauts de ligne ou de colonne peuvent exister dans le méme classeur. Si vous souhaitez
supprimer tous les sauts de page du classeur :

1) Sélectionnez Affichage > Saut de page dans la barre de menu.

2) Faites un clic droit sur le classeur et choisissez Supprimer les sauts de page dans le menu
contextuel pour enlever tous les sauts de page manuel du classeur.

3) N'oubliez pas de revenir a la vue normale du classeur (Affichage > Normal).
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Options d’impression des styles de page

Quand vous utilisez des styles de page dans votre classeur, vous pouvez y inclure des options
d’impression, par exemple l'ordre des pages, les éléments a imprimer, I'échelle, etc. L'utilisation
des styles de page vous permet de définir et de changer rapidement les options d’impression des
différentes feuilles du classeur. Voyez le chapitre 4, Utiliser les styles et les modéles dans Calc,
pour plus d’'informations sur les styles de page.

Veérifiez que vous avez sélectionné la bonne feuille dans le classeur avant de définir les options
d’'impression. Sélectionnez Format > Page dans la barre de menu pour ouvrir la boite de dialogue
Style de page puis cliquez sur I'onglet Feuille (Figure 14) pour paramétrer les options d'impression
du style de page. Le titre de la boite de dialogue précise le nom du style de page que vous étes
sur le point de modifier.

Style de page: Par défaut
Gestionnaire Page Bordures Arriére-plan En-téte Pied de page Feuille

Ordre des pages

® De haut en bas, puis vers la droite

(O De gauche & droite, puis vers le bas

[“IPremier numéro de page : 1 =
Imprimer
[1En-tétes de colonne et de ligne Diagrammes
[Grille [“1Objets de dessin
[1Commentaires [IFormules
[“IObjets/images [“IValeurs zéro
Echelle
Mode d'échelle : |Réduire/agrandir I'impression ~
Facteur d'échelle : 100% =

Réinitialiser oK Annuler

Figure 14 : I'onglet Feuille de la boite de dialogue Style de page.

Ordre des pages
Définissez I'ordre dans lequel les données d’une feuille sont imprimées et les pages numéro-
tées quand elles ne tiennent pas sur une seule page. Un apercu de I'ordre des pages est vi-
sible en haut a gauche de la boite de dialogue sur la Figure 14.

— De haut en bas, puis vers la droite : les données sont imprimées verticalement jusqu’en
bas de la colonne de gauche puis dans la colonne de droite.

— De gauche a droite, puis vers le bas : les données sont imprimées horizontalement jus-
gu’au bord droit puis en dessous.

— Premier numéro de page cochez cette option et saisissez le numéro de la premiére page
si vous voulez commencer avec un autre numéro que 1.

Imprimer
Définissez ici les éléments du classeur qui doivent étre imprimés.

— En-tétes de colonne et de ligne imprime les numéros de lignes et les lettres des colonnes.
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— Grille imprime les bordures des cellules pour former une grille. Pour I'affichage a I'écran,
définissez votre préférence dans la page LibreOffice Calc — Affichage de la boite de dia-
logue Options (Outils > Options) dans la liste Lignes de la grille.

— Commentaires imprime les commentaires définis dans le classeur. lls seront imprimés sur
une page séparée, accompagnés de la référence de la cellule correspondante.

— Objets/Images imprime tous les objets imprimables et les images insérés dans le clas-
seur.

— Diagrammes imprime les diagrammes insérés dans le classeur.
— Objets de dessin imprime tous les dessins créés avec les outils de LibreOffice.
— Formules imprime les formules contenues dans les cellules a la place de leurs résultats.

— Valeurs zéro précise que les cellules contenant une valeur zéro sont imprimée avec un
zéro (0).

Echelle
Vous définissez ici I'échelle qu’aura le classeur imprimé sur la page en choisissant une op-
tion dans la liste déroulante Mode d’échelle. Les contrbles appropriés apparaitront sous la
liste.

— Réduire / agrandir I'impression : vous pouvez spécifier un facteur d’échelle en pourcen-
tage dans la boite de saisie.

— Adapter les zones d’'impression en largeur et en hauteur : vous spécifiez le nombre maxi-
mum de feuilles de papier sur lesquelles les pages qui ont ce style seront imprimées dans
le sens horizontal (Largeur en pages) et vertical (Hauteur en pages).

Les zones d'impression sont toujours mises a I'échelle de maniére proportionnelle, si bien
gue le nombre de page peut étre inférieur a celui spécifié.

Vous pouvez effacer le contenu d’'une des boites de saisie pour indiquer qu'il faut utiliser,
pour cette dimension, autant de pages que nécessaire. Si vous effacer le contenu des
deux, le facteur d’échelle sera 100 %.

— Adapter les zones d’'impression au nombre de page : vous spécifiez, dans le champ
Nombre de pages, le nombre maximum de feuilles de papier sur lesquelles les pages qui
ont ce style seront imprimées. L'échelle sera alors réduite autant que nécessaire pour ne
pas le dépasser

En-tétes et pieds de pages

Les en-tétes et pieds de page sont des éléments de texte imprimés en haut ou en bas de chaque
feuille imprimée, hors de la zone d’'impression des données. lls se paramétrent de la méme ma-
niére et peuvent avoir un contenu différent pour les pages de gauche et de droite qui utilisent le
méme style.

Paramétrer les en-tétes et pieds de page

Pour activer les en-tétes ou les pieds de page dans votre classeur :

1) Sélectionnez la feuille dont vous souhaitez activer I'en-téte ou le pied de page.
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2) Choisissez Format > Page dans la barre de menu pour ouvrir la boite de dialogue Style de
page puis cliquez sur I'onglet En-téte ou Pied de page (Figure 15). Les deux onglets sont
identiques.

3) Cochez Activer I'en-téte ou Activer le pied de page.
4) Saisissez les valeurs des autres options selon vos désirs. Elles sont décrites ci-dessous.

5) Cliquez sur OK pour enregistrer les modifications et refermer la boite de dialogue.

Style de page: Par défaut

Gestionnaire Page Bordures Arriére-plan En-téte Pied de page Feuille
En-téte
[MActiver 'en-téte

Méme contenu sur les pages de droite et de gauche

Marge gauche : 000cm 5
Marge droite : 000cm 5
Espacement: 025cm -
Hauteur : 0,50 cm =

[1 Adaptation dynamique de la hauteur

Plus... Editer...

Figure 15 : I'onglet En-téte de la boite de dialogue Style de page.

Activer I'’en-téte ou Activer le pied de page
Cochez cette option pour ajouter un en-téte ou un pied de page au style que vous modifiez.

Méme contenu sur les pages de droite et de gauche
Si cette option est cochée, les pages de droite et de gauche partagent le méme contenu.
Pour leur affecter un en-téte ou un pied de page différent, décochez-la et cliquez sur Editer.
Voir « Contenu des en-tétes et pieds de page » ci-dessous pour plus d’'informations.

Marge de gauche
Saisissez la distance entre la marge de gauche et le bord gauche de I'en-téte ou du pied de

page.
Marge de droite
Saisissez la distance entre la marge de droite et le bord droit de I'en-téte ou du pied de page.

Espacement
Saisissez la distance entre le bas de I'en-téte et le haut de la zone imprimée ou le haut du
pied de page et le bas de la zone imprimée.

Hauteur
Saisissez la hauteur de I'en-téte ou du pied de page.

Adaptation dynamique de la hauteur
Cochez cette option pour que la hauteur de I'en-téte ou du pied de page s’adapte automati-
guement & son contenu.

Une figure vous donne un apercu des résultats de vos choix.
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Plus
Ce bouton ouvre une boite de dialogue Bordure / Arriére-plan ou vous pouvez définir 'appa-
rence des bordures et de l'arriere-plan de I'en-téte ou du pied de page. Voir le chapitre 4,
Utiliser les styles et les modéles dans Calc, pour plus d’informations.

Editer
Ce bouton ouvre la boite de dialogue En-téte ou Pied de page ou vous pouvez ajouter, modi-
fier ou formater le texte placé dans I'en-téte ou le pied de page. Voir ci-dessous pour plus
d’'informations.

Contenu des en-tétes et pieds de page

Dans un classeur de Calc, les en-tétes et les pieds de page disposent de trois colonnes de texte
gui peuvent soit étre vides, soit avoir un contenu différent des autres colonnes.

1) Sélectionnez la feuille dont vous souhaitez activer I'en-téte ou le pied de page.

2) Choisissez Format > Page dans la barre de menu pour ouvrir la boite de dialogue Style de
page puis cliquez sur I'onglet En-téte ou Pied de page (Figure 15). Voir « Paramétrer les en-
tétes et pieds de page » ci-dessus.

3)  Cliquez sur le bouton Editer pour ouvrir la boite de dialogue En-téte ou Pied de page (Figure
16). Si I'option Méme contenu sur les pages de droite et de gauche n’est pas cochée dans la
boite de dialogue Style de page, celui-ci aura des onglets ou vous pourrez définir le contenu
de I'en-téte ou du pied de page des pages de droite et de gauche.

En-téte (Style de page: Par défaut)

Zone gauche Zone centrale Zone droite
Feuillel
En-téte ‘Feu'\lle1 V‘
En-téte personnalisé vy B & % C)
Remarque
Utilisez les boutons pour modifier la police ou pour insérer des champs tels que la date, I'heure, etc.
Aide Annuler

Figure 16 : le dialogue En-téte

4)  Vous pouvez sélectionner une option dans la liste déroulante En-téte (ou Pied de page) par-
mi une série d’options standards.

5)  Pour saisir un contenu personnalisé, cliguez dans I'une des zones de saisie et tapez votre
texte ou cliquez sur I'un des boutons de la section En-téte (ou Pied de page) personnalisé.
Leurs fonctions sont présentées ci-dessous.

6) Pour modifier I'apparence du texte dans I'en-téte ou le pied de page, cliquez sur le bouton
Attributs de texte pour ouvrir une boite de dialogue Attributs de texte ou vous pourrez

définir la police, les effets de caracteres et leurs positions.
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7)  Cliguez sur OK pour enregistrer les modifications des attributs du texte et refermer cette
boite de dialogue.

8) Cliquez sur OK pour enregistrer le contenu de I'en-téte ou du pied de page et refermer la
boite de dialogue En-téte (ou Pied de page).

9) Cliguez sur OK pour enregistrer les modifications de I'en-téte ou du pied de page dans le
style de page et refermer la boite de dialogue correspondante.

Les boutons de la section En-téte (ou Pied de page) personnalisé ont, de gauche a droite, les
fonctions suivantes :

Attributs de texte
Ouvre une boite de dialogue Attributs de texte ou vous pourrez définir la mise en forme d'un
texte nouveau ou sélectionné. Celle-ci contient des onglets pour paramétrer la Police, les Ef-
fets de caractéres et leur Position.

Titre
Déroule une liste ou vous pouvez choisir d’'insérer dans la zone sélectionnée un emplace-
ment pour le Titre, le Nom de fichier ou le Chemin/Nom de fichier. Si aucun titre n’a été défini
pour le classeur, le nom du fichier qui le contient sera inséré a sa place.

Nom de feuille
Insére dans la zone sélectionnée un emplacement pour le nom de la feuille sélectionnée
dans le classeur.

Page
Insere dans la zone sélectionnée un emplacement pour le numéro de page. Cela permet une
numeérotation continue des pages du classeur.

Pages
Insére dans la zone sélectionnée un emplacement pour le nombre total de pages du clas-
seur.

Date
Insére dans la zone sélectionnée un emplacement pour la date courante qui sera répétée
dans I'en-téte ou le pied de chaque page du classeur.

Heure
Insére dans la zone sélectionnée un emplacement pour I’heure courante qui sera répétée
dans I'en-téte ou le pied de chaque page du classeur.

Exporter en PDF

LibreOffice peut exporter des documents en PDF (Portable Document Format). Ce format de fi-
chier est un standard industriel idéal pour envoyer un fichier a quelqu’un qui pourra le lire avec
Adobe Reader ou tout autre lecteur de PDF.

Un document au format PDF n’est pas protégé par défaut contre la falsification ou la modifi-
cation. Son contenu peut étre édité grace a des outils logiciels spécialisés et par LibreOffice
Draw.
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:g Remarque
Contrairement a la commande Enregistrer sous, la commande Exporter écrit une copie du
document ouvert dans un nouveau fichier au format choisi, mais garde ce document ouvert
dans son format d’origine.

Exportation rapide en PDF

Cliquez sur le bouton Exporter au format PDF (| 1) de la barre d’outils Standard pour exporter le
classeur entier avec les derniers parametres utilisés dans la boite de dialogue Options PDF (voir
ci-dessous). Il vous est demandé de saisir le nom et 'emplacement du fichier PDF, mais vous n’au-
rez pas I'occasion de choisir la plage de pages, la compression des images ni les autres options.

Controler le contenu et la qualité du fichier PDF

Pour un meilleur contrdle du contenu et de la qualité du PDF obtenu, utilisez Fichier > Exporter
au format PDF. La boite de dialogue Options PDF s’ouvre. Elle possede six onglets (Général, Vue
initiale, Interface utilisateur, Liens, Sécurité et Signatures numériques). Choisissez les parameétres
appropriés puis cliquez sur Exporter aprés quoi vous devrez saisir I'emplacement et le nom du fi-
chier PDF a créer et de cliquer sur Enregistrer pour exporter le fichier.

La boite de dialogue Options PDF - onglet Général

Dans I'onglet Général (Figure 17), vous pouvez choisir les pages a inclure dans le PDF, le type de
compression a utiliser pour les images (qui affecte leur qualité dans le PDF) et d’autres options.
Pour plus d'informations, voir le Guide du débutant ou l'aide. Dans la plupart des cas, les valeurs
par défaut conviennent.

Options PDF

Général Vue initiale Interface utilisateur Liens Sécurité Signatures numériques

Plage Général
OTout [IPDF hybride (fichier ODF incorporé)
(' Pages : [UJArchive PDF/A-Ta (ISO 19005-1)
@®Sélection/Feuille(s) sélectionnée(s)! [IPDF marqué (ajouter la structure du document)
Images [vICréer un formulaire PDF
O Compression sans perte Format d'envoi : FDF v
® Compression JPEG U Autoriser les doublons de noms de champ
Qualité : a0 % = Exporter les reperes de texte

P . . . [Exporter les commentaires
[“IRéduire la résolution des images 300 DPI |~ =P

Exporter les pages vides insérées automatiquement
] Afficher le PDF aprés export
[ Utiliser les XObjets de référence

Filigrane
[JSigner avec un filigrane

Texte :

Aide Annuler

Figure 17 : L'onglet Général de la boite de dialogue Options PDF.

Plage
— Tout : exporte la totalité du document en PDF.

— Pages : pour exporter un intervalle de pages, utilisez le format 3-6 (pages de 3 a 6). Pour
exporter des pages individuelles, utilisez le format 7 ; 9 ; 11 (pages 7, 9 et 11). Il est aussi
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Images

possible d’exporter une combinaison d’intervalles et de pages individuelles en utilisant un
format comme 3-6 ; 8 ; 10 ; 12.

Sélection/Feuille(s) sélectionnée(s) : exporte tout ce qui est sélectionné (une feuille ou
une partie de feuille).

Compression sans perte : les images sont incorporées sans aucune perte de qualité.
Avec des photographies, il peut en résulter de gros fichiers. Cette option est recomman-
dée pour les autres types d’'images ou d’'objets graphiques.

Compression JPEG : elle offre une qualité plus ou moins grande. Une qualité de 90 % est
bien adaptée aux photographies (petite taille de fichier, perte de qualité a peine percep-
tible).

Réduire la résolution des images : les images a faible DPI (Dot Per Inch : point par pouce)
ont une qualité plus faible. Pour les regarder sur I'écran d’un ordinateur, une résolution de
72 dpi (sous Windows) ou 96 dpi (sous GNU/Linux) est généralement suffisante, alors
gue pour lI'impression il est souvent préférable d’utiliser au moins 300 ou 600 dpi selon les
possibilités de I'imprimante. Une valeur élevée des DPI augmente fortement la taille du fi-
chier exporté.

Filigrane

Général

Signer avec un filigrane : quand cette option est cochée, une couche transparente conte-
nant le texte que vous saisirez dans la boite Texte apparaitra sur chague page du PDF.

PDF hybride (fichier ODF incorporé) : cochez cette option pour exporter le document
comme fichier PDF contenant deux formats de fichiers : PDF et ODF. Dans les lecteurs de
PDF, il se comporte comme un fichier PDF normal et il reste totalement modifiable dans
LibreOffice.

Archive PDF/A-1a (ISO 19005-1) : PDF/A est un standard 1SO pour la conservation a long
terme des documents en y incorporant toutes les informations nécessaires a une repro-
duction fidele (telles que les polices) et en excluant d’autres éléments (y compris les for-
mulaires, la sécurité et I'encodage). Les balises PDF sont écrites. Si vous cochez PDF/A-
la, les éléments interdits sont grisés (non disponibles).

PDF marqué (ajouter la structure du document) : les PDF marqués contiennent des infor-
mations sur la structure du contenu du document. Cela peut aider a afficher ce document
sur des appareils possédant des écrans différents ou si on utilise un logiciel de lecture
d’écran. Parmi les marques exportées, il y a la table des matiéres, les hyperliens et les
contrdles. Cette option peut augmenter de facon significative la taille des fichiers.

Créer un formulaire PDF — Format d’envoi : choisissez le format des formulaires envoyés
depuis le fichier PDF.

Autoriser les doublons de noms de champs : si cette option est cochée, le méme nom
peut étre utilisé pour plusieurs champs dans le fichier PDF produit. Sinon, les noms de
champs seront exportés avec des noms unigues générés a cette fin.

Exporter les repéres de texte : cette option n’est généralement pas utilisée avec Calc.

Exporter les commentaires . exporte les commentaires sous forme de notes PDF. Ce n’est
peut-étre pas ce que vous désirez !
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— Exporter les pages vides insérées automatiquement : cette option n’est pas accessible
dans Calc.

— Afficher le PDF aprés export : si cette option est cochée, votre lecteur de PDF par défaut
va s’ouvrir pour afficher le fichier PDF qui vient d’étre exporté.

— Utiliser les XObjets de référence : si vous ne connaissez pas le sens de cette option, ne la
cochez pas.

La boite de dialogue Options PDF - onglet Vue initiale

Options PDF

Général Vue initiale Interface utilisateur Liens Sécurité Signatures numériques

Volets Mise en page
@®Page uniquement| @® Par défaut
ORepéres de texte et page OUne page
O Miniatures et page O Continu
Ouvrir a la page : |1 = OCéte a cote

Agrandissement
@® Par défaut
O Adapter & la fenétre
O Adapter & la largeur
(C Adapter au visible

s

O Facteur de zoom: 100

Figure 18 : L’'onglet Vue initiale de la boite de dialogue Options PDF.

Dans l'onglet Vue Initiale (Figure 18), vous pouvez choisir comment le PDF s’ouvre par défaut
dans le lecteur PDF. Les choix devraient se comprendre d’eux-mémes.

La boite de dialogue Options PDF - onglet Interface utilisateur

Dans l'onglet Interface utilisateur (Figure 19), vous pouvez choisir d’autres options pour contrbler
la fagon dont le fichier sera affiché par un lecteur de PDF. Certains de ces choix sont particuliere-
ment utiles si vous créez un PDF destiné a une présentation ou une borne interactive.

Options PDF

Général Vue initiale Interface utilisateur Liens Sécurité Signatures numériques

Options de fenétre Options d'interface utilisateur
CJRedimensionner la fenétre selon la page initiale.  [1Masquer la barre de menu
[ICentrer la fenétre a I'écran [[IMasquer la barre d'outils
[JQuvrir en mode plein écran [[IMasquer les contrdles de la fenétre

[ Afficher le titre du document

Transitions Repéres de texte
Utiliser les effets de transition ® Tous les niveaux de repéres de texte
O Niveaux de repéres de texte visibles : S

Figure 19 : L’'onglet Interface utilisateur de la boite de dialogue Options PDF.

Options de fenétre
— Redimensionner la fenétre selon la page initiale : provoque 'adaptation de la fenétre du
lecteur de PDF aux dimensions de la premiére page du fichier.

— Centrer la fenétre a I'écran : centre la fenétre du lecteur de PDF sur I'’écran de 'ordina-
teur.
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— OQuvrir en mode plein écran : ouvre le lecteur de PDF en plein écran au lieu du mode fené-
tré.

— Afficher le titre du document : affiche le titre du document dans la barre de titre du lecteur
de PDF.

Transitions
Section non utilisée dans Calc.

Options d’interface utilisateur
— Masquer la barre de menu : masque la barre de menu du lecteur de PDF.

— Masquer la barre d’outils : masque la barre d’outils du lecteur de PDF.

— Masquer les contrbles de la fenétre : masque les autres contrdles de la fenétre du lecteur
de PDF.

Repéres de texte
— Tous les niveaux de repéres de texte : affiche tous les niveaux de repéres de texte a I'ou-
verture du fichier PDF.

— Niveaux de repéeres de texte visibles : choisissez le niveau jusqu’auquel les repéres de
texte seront affichés a I'ouverture du fichier PDF.

La boite de dialogue Options PDF - onglet Liens

Dans l'onglet Liens (Figure 20), vous pouvez définir la maniére dont les reperes de texte et les hy-
perliens sont exportés dans le PDF.

Options PDF X

Général Vue initiale Interface utilisateur Liens Sécurité Signatures numériques

Géneral

[Exporter les repéres de texte comme destinations nommées

[IConvertir les références de document en cibles PDF
Exporter les URL relatifs au systéme de fichier
Liens entre documents
® Mode par défaut
O Ouvrir avec un lecteur de PDF

O Quvrir avec un navigateur Internet

Figure 20 : L'onglet Liens de la boite de dialogue Options PDF.

Général
— Exporter les repéres de texte comme destinations nommeées : si vous avez défini des
noms de feuille dans Calc, cette option les exporte en tant que « destinations nommeées »
auxquelles les pages Web et les documents PDF peuvent se référer.

— Convertir les références de document en cibles PDF : si vous avez défini des liens vers
d’autres documents avec une extension OpenDocument (comme.odt,.ods ou.odp), cette
option remplace ces extensions par.pdf dans le document PDF exporté.

— Exporter les URL relatives au systéme de fichier : si vous avez défini des liens relatifs
dans un document, cette option les exporte dans le PDF. Voir « Hyperliens relatifs et ab-
solus » dans l'aide de Calc.
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Liens entre documents
Cette option définit le comportement des liens sur lesquels vous cliqguez dans les fichiers
PDF. Choisissez une option parmi les suivantes :

— Mode par défaut : les liens PDF seront gérés comme il est spécifié dans votre systeme
d’exploitation.

— Ouvrir avec un lecteur de PDF : utiliser I'application qui a servi a afficher le document PDF
pour ouvrir les documents PDF liés.

— Ouvrir avec un navigateur Internet : utiliser le navigateur Internet par défaut pour afficher
les documents PDF liés.

La boite de dialogue Options PDF - onglet Sécurité

L'exportation des PDF comporte des options pour encoder et définir des mots de passe quand
vous exportez le classeur et créez le PDF. Cela permet aussi d’appliquer des restrictions d'impres-
sion et de définir si les modifications et la copie du fichier PDF sont autorisées.

*  Quand un mot de passe d’ouverture est défini, le PDF ne peut étre ouvert qu’avec celui-ci.
Une fois ouvert, l'utilisateur n’est soumis a aucune restriction sur ce qu'il peut faire (par
exemple, l'imprimer, le copier ou le modifier).

*  Quand un mot de passe d’autorisation est défini, le PDF peut étre ouvert par n'importe qui,
mais son utilisation peut étre soumise a restrictions. Voir la Figure 21. Quand vous avez défi-
ni un mot de passe d’autorisation, les autres options de I'onglet Sécurité deviennent acces-
sibles.

*  Siles deux types de mots de passe sont définis, le PDF ne peut étre ouvert qu’avec le mot
de passe correct et son utilisation peut étre restreinte.

Les options de I'onglet Sécurité ne sont accessibles qu’aprés la création des mots de passe.

Options PDF

Général Vue initiale Interface utilisateur Liens Sécurité Signatures numériques

Permission et chiffrement du fichier Impression

| Définir les mots de passe.... | 2 Non autorisé
© Basse résolution (150 dpi)

Aucun mot de passe d'ouverture défini

o ® Haute résolution
Le document PDF ne sera pas chiffré

— . Modifications
Mot de passe d'autorisation défini

Le document PDF aura des restrictions ©Non autorisé

O Insertion, suppression et rotation de pages
O Remplissage de champs de formulaire
O Commentaires, remplissage dans les champs de formulaire

® Tout sauf extraire les pages
Contenu
 Autoriser la copie de contenu

M Autoriser I'acces au texte des outils d'accessibilité

Figure 21 : L’'onglet Sécurité de la boite de dialogue Options PDF.

=2

I=| Remarque

Le paramétrage des autorisations n'a d’effet que si le lecteur de PDF de I'utilisateur le res-
pecte.
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La Figure 22 montre la boite de dialogue qui s’affiche quand vous cliquez sur le bouton Définir les
mots de passe dans I'onglet Sécurité de la boite de dialogue Options PDF.

Définir les mots de passe

Déf. mot de passe d'ouverture
Mot de passe : [ssssssss
Confirmer: seveeane

Déf. mot de passe d'autorisation
Mot de passe:

Confirmer :

Aide OK Annuler

Figure 22 : Définir un mot de passe pour encoder un fichier PDF.

La boite de dialogue Options PDF - onglet Signatures numériques
Cet onglet contient les options qui concernent I'exportation de PDF signés numériqguement.

Les signatures numériques permettent d'assurer que le PDF a réellement été créé par son auteur
initial (vous) et qu'’il n’a pas été modifié depuis lors.

L'exportation de PDF signés utilise les clés et certificats X.509 déja stockés dans votre dép6t de
certificats par défaut ou sur une carte a puce. Sous Linux ou Mac OS le dépot a utiliser peut étre
sélectionné en dans la page LibreOffice > Sécurité > Chemin du certificat de la boite de dialogue
Options (cliquez sur Outils > Options dans la barre de menu) ; sous Windows, le dép6t de certifi-
cats par défaut est toujours utilisé. Si vous utilisez une carte a puce, elle doit étre déja configurée
pour étre utilisée par votre dépdt. Cela se fait normalement pendant l'installation de son logiciel.
Les détails concernant l'utilisation de ces propriétés sortent du cadre de ce chapitre.

Options PDF

Général Vue initiale Interface utilisateur Liens Sécurité Signatures numériques

Certificat

Utiliser ce certificat pour signer numériquement les documents PDF :
Sélectionner... Effacer
Mot de passe du certificat :
Emplacement :
Information de contact :

Raison :

Autorité d'horodatage |.i:u-:u|‘e |

Figure 23 : L'onglet Signatures numeériques de la boite de dialogue Options PDF.

«  Utiliser ce certificat pour signer numériquement les documents PDF : cliquez sur Sélection-
ner pour ouvrir la boite de dialogue Sélectionner le certificat ou tous les certificats trouvés
dans le dépét sélectionné sont affichés. Si ce dépbt est protégé par un mot de passe, il vous
est demandé. Quand vous utilisez une carte a puce protégée par un code PIN, celui-ci vous
est aussi demande.
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Sélectionnez le certificat a utiliser pour signer numériquement le PDF exporté puis cliquez
sur OK. Tous les autres champs de l'onglet ne sont accessibles qu'aprés le choix d’'un certifi-
cat.

Mot de passe du certificat : saisissez le mot de passe utilisé pour protéger la clé privée asso-
ciée au certificat choisi. C’est habituellement le mot de passe du dép6t. Si celui-ci a déja été
saisi dans la boite de dialogue Sélectionner le certificat, le dépbt peut déja étre déverrouillé
et ne pas redemander le mot de passe.

Si vous utilisez une carte a puce, entrez ici le code PIN. Certains logiciels de cartes a puce
vous demanderont de nouveau ce code avant de signer.

Emplacement, Information de contact, Raison : vous pouvez saisir des informations supplé-
mentaires facultatives concernant la signature numérique qui sera appliquée au PDF. Celles-
ci seront incorporées dans les champs appropriés du PDF et visibles par quicongue ouvrira
le fichier. Tout ou partie de ces trois champs peut étre laissé vide.

Autorité d’horodatage : vous pouvez choisir 'TURL d’'une Autorité d’horodatage (Time Stamp-
ing Authority : TSA). Pendant le processus de signature du PDF, la TSA sera utilisée pour ob-
tenir la date et I'heure signées numériguement qui seront incorporées a la signature. Si quel-
gu’'un ouvre le PDF, il pourra utiliser cette information pour vérifier quand le document a été
signé.

La liste des URL des autorités d’horodatage qui peuvent étre choisies est conservée sous
Outils > Options > LibreOffice > Sécurité > Autorités d’horodatage (TSA). Si aucune
URL d’une autorité d’horodatage n’est sélectionnée (cas par défaut), la date et I'heure de la
signature ne seront pas certifiées mais seront celles de votre ordinateur local.

Exporter vers d’autres formats

LibreOffice utilise le terme « exporter » pour des opérations qui impliqguent un changement de type
de document. Si vous voulez utiliser un autre format de classeur (par exemple, Microsoft Excel),
utilisez Fichier > Enregistrer sous Si vous voulez créer une page web a partir de votre classeur,
utilisez Fichier > Exporter

Envoyer des classeurs par courriel

LibreOffice propose plusieurs moyens pour envoyer rapidement et facilement des documents
comme piéces jointes a des courriels dans le format OpenDocument (format par défaut de
LibreOffice), dans d'autres formats de classeur ou sous forme de fichier PDF.

Pour envoyer le classeur comme courriel :

1)

Sélectionnez Fichier > Envoyer dans la barre de menu et choisissez une des options sui-
vantes dans le sous-menu. LibreOffice ouvre votre programme de courrier électronique par
défaut. Le document est attaché en piéce jointe.

a) Document par e-mail : le classeur est envoyé dans le format ODF par défaut.

b) Envoyer par e-mail en classeur OpenDocument... : le classeur est envoyé en format
ODF.

c) Envoyer par e-mail en Microsoft Excel... : le classeur est envoyé en format Excel.
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d) Envoyer par e-mail en PDF... : la boite de dialogue Options PDF s’ouvre pour vous per-
mettre de choisir les parametres a utiliser pour le fichier PDF. Voir « Controler le contenu
et la qualité du fichier PDF », page 17.

2) Dans ce programme, indiquez le destinataire, le sujet et ajoutez le texte que vous désirez
puis envoyez le courriel.

Sighature nhumérique des documents

Pour signer numériqguement un document, vous avez besoin d’une clé personnelle appelée aussi
certificat. Celle-ci est stockée sur votre ordinateur sous forme d’une combinaison d’'une clé privée,
qui doit étre gardée secréte, et d’'une clé publique, que vous ajoutez a votre document quand vous
le signez. Vous pouvez obtenir un certificat d’'une autorité de certification qui peut étre une société
privée ou une institution gouvernementale.

Quand vous appliquez une signature numérique a un document, une sorte de somme de contrble
est calculée a partir du contenu du document et de votre clé personnelle. Cette somme de contrdle
et votre clé publique sont stockées ensemble dans le document.

Quand quelqu’un ouvre par la suite le document sur n'importe quel ordinateur avec une version ré-
cente de LibreOffice, le programme recalcule la somme de contrdle et la compare a celle qui est
stockée. Si les deux sont identiques, le programme vous signale que vous voyez le document ori-
ginal non modifié. En supplément, il peut vous montrer les informations de la clé publique a partir
du certificat. Vous pouvez comparer la clé publique avec celle qui est publiée sur le site web de
I'autorité de certification. Dés que quelqu’un modifie quelgue chose dans le document, le change-
ment casse la signature numeérique.

Sous les systémes d’exploitation Windows, les fonctions de validation de signature de Windows
sont utilisées. Sous Linux, les fichiers qui sont fournis par Thunderbird, Mozilla ou Firefox sont utili-
sés. Pour une description plus détaillée de la fagon d’obtenir et de gérer un certificat et une valida-
tion de signature, voyez « A propos des signatures numériques » dans I'Aide de LibreOffice.

Appliquer une signature numérique

La procédure ci-dessous n’est qu'un exemple de la fagon dont on signe un document numérique-
ment. La procédure a appliquer effectivement dépend des paramétres de votre ordinateur et de
son systéeme d’exploitation.

1) Ouvrez le fichier que vous souhaitez signer numériquement.
2) Choisissez Fichier > Signatures numériques > Signatures numériques

Si vous avez configuré LibreOffice pour vous avertir quand le document contient des com-
mentaires (voir « Supprimer les données personnelles » ci-dessous), une boite de mes-
sage peut apparaitre pour vous demander si vous voulez continuer la signature du docu-
ment. Cliquez sur Oui pour continuer ou sur Non par arréter et supprimer les commentaires
avant de relancer la procédure.

Si vous n'avez pas enregistré le document depuis la derniére modification, un message ap-
parait. Cliquez sur Oui pour enregistrer le fichier.

3) La boite de dialogue Signatures numériques s'ouvre (Figure 24). Cliquez sur Signer le do-
cument pour ajouter une clé publique au document.
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Signatures numériques

Les personnes suivantes ont signé le contenu du document :

|Signé par ‘ID numérique délivrée par ‘Date ‘Description |Type de signature

4 Utiliser une signature compatible AdES quand il y a le choix

Afficher le certificat... Signer le document.. Supprimer Démarrer le gestionnaire de certificats...

Figure 24 : Signatures du document.

4) Dans la boite de dialogue Sélectionner le certificat (Figure 25), choisissez votre certificat et
cliquez sur OK pour revenir a la boite de dialogue Signatures numériques.

Le certificat utilisé s’affiche dans la boite de dialogue précédé d’'une icbne qui indique I'état
de la signature numérique :

— Une icbne avec un sceau rouge (E'_Q) indique que le document a été signé et le certificat
valideé.

N , . . May . .
— Une icbne avec un panneau d’avertissement jaune sur un sceau rouge (.. @) indique que
le document est signé mais que le certificat n'a pas pu étre validé.

— Une icbne avec un panneau d'avertissement jaune () indique une signature numérique
incorrecte.

Sélectionner le certificat

Sélectionnez le certificat a utiliser pour la signature :

Emis pour Emis par Utilisation du certificat Date d'expiration
cd56621d24ad65e1

Signature numérique, Chiffrement de clé 17/02/2017

Afficher le certificat...

Description :

Aide Annuler

Figure 25 : la boite de dialogue Sélectionner le certificat.

5) Cliquez sur Fermer pour appliquer la signature numérique.

Un document signé affiche une icone dans la barre d’'état. Un double clic sur cette icone vous per-
met de voir le certificat. Plusieurs signatures peuvent étre ajoutées a un document.
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= Remarque

Si vous apportez des modifications au document aprés sa signature humérique, celle-ci est auto-
matiquement supprimée et vous devez recommencer la procédure ci-dessus pour le signer de
nouveau.

Signer plusieurs fois avec la méme signature

Auparavant, LibreOffice interdisait la création de signatures multiples d’'un document par le méme
auteur, car signer plusieurs fois le méme document n’avait aucune signification sémantique.
LibreOffice offre désormais une description de signature, si bien que des signatures multiples du
méme auteur sont autorisées, car chacune peut avoir une signification différente.

Quand vous sélectionnez Fichier > Signatures humériques > Sighatures numériques, la boite
de dialogue Signatures numériques (Figure 24) affiche les signatures existantes ainsi que leurs
descriptions (le cas échéant).

Quand vous cliquez sur Signer le document, la boite de dialogue Sélectionner le certificat (Figure
25) vous demande maintenant une description qui reste facultative.

Modifier la valeur d’'une description existante invalide la signature.

Signer humériquement les macros

Normalement, les macros font partie d’'un document. Si vous signer celui-ci, les macros qu'il
contient sont automatiquement signées. Si vous souhaitez ne signer que les macros, mais pas le
document, sélectionnez Outils > Macros > Signature numérique dans la barre de menu et appo-
ser une signature comme décrit ci-dessus.

Supprimer les données personnelles

Vous aurez peut-étre envie d’étre certain que les données personnelles, les versions, les notes, les
informations cachées ou les modifications enregistrées ont été supprimées des fichiers avant de
les envoyer a d’autres personnes ou de vous en servir pour créer des PDF.

+ Dans la section Options et avertissements de sécurité de la page LibreOffice — Sécurité
de la boite de dialogue Options (Outils > Options), vous pouvez configurer LibreOffice pour
qu’il vous rappelle (qu'il vous avertisse) quand les fichiers contiennent certaines informations
et pour qu'il supprime automatiquement les informations personnelles a I'enregistrement.

«  Pour supprimer les données personnelles, et quelques autres, d’un fichier, sélectionnez Fi-
chier > Propriétés Dans I'onglet Général, décochez Utiliser les données d’identité puis cli-
quez sur Réinitialiser les propriétés. Cela supprime les noms dans les champs Créé et
Maodifié, efface les dates de modification et d'impression et remet la durée totale d’édition a
zéro, la date et I'neure de création a leurs valeurs courantes et le numéro de révision a 1.

*  Pour supprimer les informations de version, vous pouvez soit sélectionner Fichier > Ver-
sions dans la barre de menu, choisir une version dans la liste puis cliquer sur Supprimer,
soit sélectionner Fichier > Enregistrer sous et sauvegarder le fichier sous un autre nom.
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